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Introduction to PartMaker/Advanced 
Surface Machining (ASM) Module 
Introduction  

PartMaker/Advanced Surface Machining Module (ASM) includes toolpath-generation 
machining strategies for milling free-shape surfaces using Machining Centers 
(PartMaker/Mill), Turn-Mill Centers (PartMaker/Turn-Mill) and Swiss-type Lathes 
(PartMaker/SwissCAM) equipped with Live Tooling.  

To use ASM, you need the ASM cost option. 

 

Key issues in milling of complex shapes are: 

 Accuracy and finish of the part.  

 Convenience in generation of desired toolpaths.  

 The time spent preparing and validating toolpaths prior to machining.  

 The machine-time required to complete the operation. 

It is also important that the toolpaths are correct and that the tool does not gouge 
the part or leave material in unexpected portions. ASM addresses all these key 
issues. It implements algorithms that dramatically cut down the time required for 
manufacturing of parts. Inputs required by ASM can be provided as an imported 
Solid Model. The user has the ability to machine the entire model or he or she can 
select certain sections using the mouse. Subsequent to this, ASM operates without 
any intervention and produces toolpaths as specified. ASM ensures that the 
toolpaths are mathematically accurate and gouge-free to the given tolerance. 
Desired toolpath geometry and the surface finish are obtained with appropriate 
choice of settings used to generate the toolpaths. 

The machining strategies in ASM are fast, safe and reliable. They cover different 
phases of milling, namely, Roughing, Finishing, Remachining and Projection 
Machining. For each phase, toolpaths in various machining styles are possible, also 
known as strategies. For each machining strategy, further variation in the toolpath 
can be introduced by using different boundary conditions, transitions, entry or exit 
conditions and other toolpath parameters. 
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Major Features 

Input Options 
 Imported Solid Models: Parasolid Files (*.x_t, *.x_b), SolidWorks Files 

(*.sldprt), Inventor Files (*.ipt), STEP (*.STEP, *.STP) and STL files (*.stl).  

 Boundary curves and Projection Curves are constructed as standard 
PartMaker Profiles 

Surface Machining Options 
Roughing 

 Model Area Clearance – Includes Raster and Offset roughing 

Finishing  

 Raster Finishing 

 Raster Flat Finishing 

 3D Offset Finishing 

 Offset Flat Finishing 

 Constant Z Finishing 

 Steep and Shallow Finishing 

 Radial Finishing 

 Spiral Finishing 

 Rotary Finishing 

Remachining  

 Corner Finishing 

 Corner Pencil  

Projection  

 Pattern Finishing 

Cutting Limits and Constraints Options 
 Machining of the entire model  

 Machining of mouse-selected sections  

 Usage of Boundary Curves as defined by Limits  

 User-Defined and Selected Surface Limits 

Milling Tool Types Options 
 Ball Nose Tool  

 Bull Nose Tool  

 Flat End Tool  

 Taper End Tool 

 Lollipop Tool 

 Slotting Cutters 
  



 

Copyright @2014 Delcam Ltd  User Guide 3  

 

Surface and Tool Orientation Options 
ASM for PartMaker/Mill supports:  

 3-Axis Milling with Z-oriented Tools 

ASM for PartMaker/SwissCAM supports:  

 3-Axis Milling with Z-oriented Tools (Face Type: Mill XY Plane) on either 
stationary or moving stock  

 3-Axis Milling with X-Oriented Tools (Face Type: Mill ZY Plane) on either 
stationary or moving stock  

 3-Axis Milling with Arbitrarily-Oriented Tools (Face Type: Mill 5-Axis Plane) 
on either stationary or moving stock 

 Polar Milling with Z-oriented Tools (Face Type: Mill End Polar) on either 
stationary or moving stock  

 Polar Milling with X-oriented Tools (Face Type: Mill Diameter Polar) on either 
stationary or moving stock 

 Cylindrical Milling with X-oriented Tools (Face Type: Mill Diameter Polar) on 
either stationary or moving stock 

ASM for PartMaker/Turn-Mill supports :  

 3-Axis Milling with Z-oriented Tools (Face Type: Mill XY Plane)  

 3-Axis Milling with X-Oriented Tools (Face Type: Mill ZY Plane)  

 Polar Milling with Z-oriented Tools (Face Type: Mill End Polar)  

 Polar Milling with X-oriented Tools (Face Type: Mill Diameter Polar) 

 Cylindrical Milling with X-oriented Tools (Face Type: Mill Diameter Polar) on 
either stationary or moving stock 
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What Makes ASM Unique? 
The ASM module provides PartMaker users a powerful, yet easy to use tool for 
programming parts with complex geometry or those requiring advanced machining 
strategies.  PartMaker’s ASM module is totally unique to many other 3D surfacing 
packages on the market today for the following reasons: 

Developed In House, Not Licensed – Unlike other CAM vendors who license 
the algorithms that underlie their surfacing software, Delcam develops all of its 
software in house through its industry leading development team numbering 
over 200 strong, the largest CAM development team in the industry.  By 
providing you with technology we develop rather than license, we are able to 
provide you more intelligent, better supported software which will give you the 
competitive edge for less cost. The surfacing machining algorithms found in ASM 
are the same as those in PowerMILL, Delcam’s industry leading CAM system for 
the manufacture of complex shapes such as those found in the mold making 
industry. 

Wide Variety of Machining Strategies and Parameters – ASM includes a 
wide variety of surfacing strategies and parameters. ASM gives you a solution to 
any complex machining challenge you may run across, assuring total control of 
the tool and surface finish each step along the way. 

The Power You Need, the Ease of you Demand – While ASM provides you 
the power of the CAM industry’s most powerful machining algorithms, it is also 
very easy to use, so you can program even the most complex jobs very quickly. 
ASM has a highly graphical user interface, making it quick to learn and easy to 
use.  The software has a very easy to follow and logical work flow. 

Fast Calculation Times – Using Delcam’s unique surface machining 
technology, ASM tool paths calculate very quickly, which means you get from 
model to finished part faster without having to wait for your tool paths to 
calculate.   

Make Any Tool Path High Speed – All ASM tool paths can be turned into “high 
speed” tool paths using technology like trochoidal milling, profile smoothing and 
raceline smoothing to allow you machine parts faster, which in turns lets you get 
your parts out the door faster and more profitably. 

Powerful Undercut Machining – ASM features a unique facility for performing 
undercut machining automatically.  This unique functionality allows you to 
program features other CAM systems cannot and can save you time by allowing 
you machine parts in one fixturing that might otherwise require multiple set-ups. 

Tuned to Rotational Parts – ASM for Turn-Mill and SwissCAM has been 
specifically developed to support the programming of parts that are cylindrical in 
nature. Programming 3D surface machining on a Swiss or Turn-Mill machine can 
be very different than doing so on a mill. ASM includes a unique Rotary Finishing 
strategy for machining 3D features on parts with rotational surfaces as well as 
unique technology for programming 3D cylindrical milling. 

Stock Model Recognition – ASM is able to know the condition of the stock at 
each step in the machining process.  Doing so means ASM can help you spend 
more time cutting chips and less time cutting air.  
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Chapter 1: Creating a Sample Part using 
PartMaker/Advanced Surface Machining 
(ASM) for Milling 
Introduction  

This tutorial is designed to help you learn PartMaker® Mill Advanced Surface 
Machining (ASM) commands and features.  

Before performing the steps in this tutorial, it is recommend you have a familiarity 
with PartMaker Mill and have completed the tutorial in Chapter 3 of the PartMaker 
Mill User’s Guide.  

 Note: You must install software from PartMaker® versions 2013 R1 or higher 
to have all support files and control functions referenced here. 

How you will Create the Sample Part 
Here are the major steps you’ll follow to create this part: 

• Start PartMaker® Mill 

• Import a Solid Model 

• Specify part boundaries 

• Set Defaults 

• Open Tools, Cycles and Material files 

• Define holes for a boring cycle 

• Define Advanced Surface Machining 
Strategy for Tapered Pocket 

• Define Advanced Surface Machining 
Strategy for Side Cavity 

• Define a drilled hole in the Center Cavity 

• Define Advanced Surface Machining 
Strategy for Center Cavity  

• Define Profiles for Contour Milling 

• Select a post processor 

• Generate a process table containing 
machining data 

• Simulate the cutting process 

• Generate an NC program for the part 
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Start PartMaker® Mill 
1 Click the PartMaker® Mill icon on the desktop.  

2 When the Setup dialog appears click the <Close> button. (The automatic 
display of the Setup dialog is controlled by Preferences). 

Import a Solid Model 
1 From the File menu choose the Import submenu.  

2 Choose the X_T Parasolid Transmit Text File… command. Open the X_T 
Parasolid part file in directory path shown here and as shown in the dialog 
below: 

C:\PartMaker_2014\pm-mill\ASM_Surface_Machining\Tutorial_ASM 

 
3 Select the file ASM_tutorial_mill.X_T and click on the <Open> button to load 

the solid model into PartMaker. 

4 Maximize the solids window by clicking the Maximize Solids Window button in 
upper right hand corner of the screen. 

 
In this tutorial, you will only be working directly on the solid model and not in 
the 2D window at all. 
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Specifying the Part Boundaries 
When importing a solid model into PartMaker, you can use the model to 
automatically set the part boundaries. You can do so as follows: 

1 Click the Define Face Plane button from Solids Window Toolbar. 

2 Check the Set Boundaries box as shown below: 

 
3 Click the <OK> button 

Doing so will have the dual purpose of both setting the part boundaries in the 
Setup dialog and the block limits in the Define Block dialog which can be accessed 
from the Surface Group Parameters dialog for each surfacing part feature. The 
Define Block dialog is important because it is used to specify the maximum and 
minimum limits within which machining can occur for a given ASM group. 

The Setup dialog in shown below: 
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The Define Block dialog is also shown here: 
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Set Defaults 
1 From the Job Optimizer menu choose the Defaults command  

2 Enter 0.5 (12.7 mm) in the Z_rapid field as shown below 

Using such a large number for your Rapid Plane may not be required for 
machining this part but it will help you see how the tool path is generated in the 
reference to the Rapid Plane. 

 

3 Under Surface Machining Module, make sure the ASM button is selected. 
Click the <Surfacing Defaults> button in the Defaults for Milling dialog. The 
Surfacing Defaults dialog will be displayed as shown below. 
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4 Expand the Common parameters item by clicking on the plus icon. The 
contents of the Common parameters should look as shown below. 

 
5 Expand the Leads and links item under Common Parameters and select 

Lead in as shown below. 

 
6 On the right side pane, choose Vertical arc from Type drop down menu. This 

should activate Distance, Angle, and Radius edit fields. 

7 Set the value for Distance as 0.2 (5.08). 

8 Set the Angle to 60 degrees. 

9 Enter 0.5 (12.7) for Radius. 
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Your dialog box will display as shown below: 

 
10 Copy the Lead in values to Lead out by clicking on the button as shown below. 

 
11 In the Common parameters tree, click on Links under Leads and links. 

12 Set the Short link type to Circular arc as shown below. 

 
13 Click <OK> to close the Surfacing Defaults dialog and return to Defaults for 

Milling dialog. 

14 Click <OK> to close Defaults for Milling dialog. 

Open Tools, Cycles and Material Files 
From File menu choose Open Tools File and open   

C:\PartMaker_2014\pm-mill\ASM_Surface_Machining\Tutorial_ASM \ASM_tutorial_mill.tdb 

From File menu choose Open Cycles File and open  
C:\PartMaker_2014\pm-mill\ASM_Surface_Machining\Tutorial_ASM \ASM_tutorial_mill.cdb 

From File menu choose Open Material File and open   
C:\PartMaker\pm-mill\Material\Alu_allw.mdb 
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Define Holes for the Boring Cycle 
The first group of holes utilizes a boring cycle. In the Hole Group Parameters 
dialog, you must specify a major diameter for the holes and select a cycle type. 
PartMaker searches the Cycles Database for a cycle that matches the parameters 
you have specified in the Hole Group Parameters dialog. To create the bored 
holes: 

1 Click anywhere in the Face Window to make it active. 

2 Choose New Hole Group from the Part Features menu to display the Hole 
Group Parameters dialog.  

3 Here you will be making a through hole, so make sure to leave the 
Through Hole box checked. 

4 Choose Bore from the Type drop down menu. 

5 Click the Extract Parameters from Solid box. 

6 Click on the bored hole in the upper left hand corner of the part as shown 
below. It will be highlighted in red: 

 
7 Click the Extract button to automatically extract all the geometric 

information about the hole into the Hole Group Parameters dialog. 
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Click <Select> to select the Bore-1 cycle 

 
8 PartMaker finds the appropriate cycle in the database, Bore-1. 

Calculated depths for each tool are displayed automatically at the bottom 
of the dialog when the appropriate cycle is found.  The dialog should 
appear as shown below: 
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9 To verify the hole shape, click the <Verify Shape> button; click the 
<Hide Shape> button under the picture to hide the hole shape and 
return to the Hole Group Parameters dialog. 

 
10 Click <Close> to return to the Face Window. 

An icon displaying the cycle name BORE-1 appears in the Job Explorer window as 
shown below. The icon is a group symbol. Each part you create in PartMaker will 
display one or more group symbol icons in the Face Window to indicate the 
various machining cycles for a part. 

 

 Important! The part feature creation selections (i.e. New Hole Group, New 
Profile Group and New Surface Group functions) found under the Part 
Features menu can also be accessed by clicking your right mouse button in 
the CAM Face Window.   
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Selecting the Bored Holes 
Now that the Hole feature is created, you can assign it to the part by clicking 
directly on the solid model. You can do so by: 

1 Select the Chain Holes on Solid Model icon 

2 Click on any of the four bored holes on the solid model. Your Face 
Window will appear as shown below. 

 

Save Your Work 
It is always a good idea to save your work at various points in the part creation 
process in PartMaker. To do so:  

1 From the File menu choose Save or press <CTRL + S> on your 
keyboard and enter the name of your job.  Here, save your job file as 
asmpractice as shown below: 

 
2 Click the <Save> button. 
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Define Holes for the Tapping Cycle 
In this section, you will specify the holes for Group 2, the tapping cycle. To do so: 

1 Choose a New Color. Click a color square in the color bar at the top of 
the Face Window different from the Sample Color. 

 
2 Choose New Hole Group from the Part Features menu to display the 

Hole Group Parameters dialog.  

3 Uncheck the Through Hole check box. 

4 Choose Tap from the Type drop down menu. 

5 Click the Extract Parameters from Solid box. 

6 Click on the tapped hole in the upper half of the part as shown below. It 
will be highlighted in red: 

 
7 Click the Extract button to automatically extract all the geometric 

information about the hole into the Hole Group Parameters dialog. 
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8 Click <Select> to select the Tap-1/2 cycle 

 
9 PartMaker finds the appropriate cycle in the database, Tap-1/2. 

Calculated depths for each tool are displayed automatically at the bottom 
of the dialog when the appropriate cycle is found.  Your completed Hole 
Group Parameters dialog should appear as shown below: 

 



 

1-14 PartMaker  Copyright @2014 Delcam Ltd 

 

10 To verify the shape of the hole, click the <Verify Shape> button; click 
the <Hide Shape> button under the picture to return to the dialog. 

 
11 Click the <Close> button to exit the dialog and return to the Face 

Window. 

A group symbol for Group 2 displays in the upper-left corner of the Face Window 
under the Tap-1/2 group icon. The cycle name Tap-1/2 appears to the right of the 
group symbol. 

 

Selecting the Tapped Holes 
Now that the Hole feature is created, you can assign it to the part by clicking 
directly on the solid model. You can do so by: 

1 Select the Chain Holes on Solid Model icon 

2 Click on either of the two tapped holes on the solid model. Your Face 
Window will appear as shown below. 
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Define Machining Strategies for the Tapered Pocket  
In this section of the tutorial you will create, bound and verify a tool path for 
roughing the tapered pocket on the imported solid model. 

Roughing the Tapered Pocket Using the Model Area Clearance Strategy 

1 Choose a New Color:    

2 Choose New Surface Group from the Face Window tool bar to display 
the Surface Group Parameters dialog.  

3 Make sure that there is a checkmark next to Roughing in the 
Operations column. 

4 Enter a tool diameter of 0.25 (6.35) 

5 Click the <Select Tools> to view the Select Tool dialog. 

6 Choose the tool T010 1/4Ball Mill and click on <Select> to return to 
Surface Group Parameters dialog. 

 
7 The Strategy drop down menu is disabled and Model Area Clearance is 

selected by default. 

Note: The Strategy drop down menu is active only for Finishing and 
Roughing operations that provide multiple strategies. 
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8 In the Group Name field enter “Rough Pocket” and press the <Enter> 
key on your keyboard or click the <Apply> button. 

 
9 Click the <Options> button to display Model Area Clearance dialog as 

shown below. 
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10 From the drop down menu, set the toolpath Style to Offset model and 
set Cut direction to Climb for both Profile and Area as shown below. 
Change the value of Thickness to 0.01 (0.254) for finishing. 

 
11 Click <OK> to return to the Surface Group Parameters dialog. 

Select Surfaces for Machining 
At this point you should still have the Surface Group Parameters dialog open. 
In the lower left hand corner of this dialog there is a framed section called 
Toolpath Settings. In this section you will control how you select surfaces to 
be machined by the current operation. There are two choices: Machine All 
Surfaces and Machine Selected Surfaces. 

Click the Machine All Surfaces radio button. As a result you will have selected 
every surface of the part to be machined. Here we will leave all the surfaces 
selected and just bound machining using a “Boundary Curve” 

Your Surface Group Parameters dialog should appear as shown below: 

 
Notice the number of selected surfaces is 69. 

Click on the <Close> button in Surface Group Parameters dialog to return to 
the Face Window. 
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Create a Boundary Curve 
Boundary curves are created the same way as 2D profile curves. They are used 
as tool path boundaries to restrict the machining area. To create a boundary 
curve to bound rough machining of the Tapered Pocket: 

1 Choose the Chain Geometry on Solid Model icon. 

2 Notice the edge end points are highlighted by orange circles as shown 
below. You can select any edge end point on the tapered pocket. 

 
3 Double click on any of the orange points of the tapered pocket. Your 

model should now appear as shown below: 
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4 Double click on the Boundary Curve you have just created with the 
Selection icon to display the Curve Properties dialog as shown below. 

 
5 In the Curve Properties dialog, notice the Curve Type is set as 

Boundary and the Boundary Type is set to User Defined. 

6 Click <OK> to close the Curve Properties dialog.  
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Verify the Tool Path 
Once you have created the Part Feature and established a Boundary Curve 
you can visually verify the tool path PartMaker has calculated. To do so: 

1 From the Face Window tool bar choose Verify Work Group Tool path.  

2 Uncheck the Enable Verification on Face Window. As we are only 
working on the solid, we do not need to see the verification in 2D. 

3 Enter a Verification Delay of 0. 

 Note: When entering a Verification Delay of greater than 0, you will see 
a 3D representation of the cutting tool moving along the Solid Model.  
When Verification Delay is set to 0, you will only see the path of the 
tool on the Solid Model. 
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4 Click <OK> to show the calculated tool path. Your screen should appear 
as shown below: 

 
5 To hide toolpath, from the Face Window tool bar click on Hide Every 

Tool path.  
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Lock the Tool Path 
Whenever creating a surfacing tool path in ASM, it is always a good idea to 
“lock” the tool path once you are satisfied with result to avoid it being 
regenerated later. To “lock” a tool path 

1 Double click on the feature in the Job Explorer tree 

2 Click the Lock Toolpath button in the Surface Group Parameters 
dialog as shown here: 

 
Once a tool path has been “locked” it will appear with a small lock next to it on 
the Feature Tree. 

Your Job Explorer tree should now appear as shown below: 

 
3 Click the <Close> button to close the Surface Group Parameters 

dialog. 
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Finishing the Tapered Pocket using Steep and Shallow Finishing 
Strategy  

In this section of the tutorial you will create, bound and verify the tool path for 
finishing the steep and shallow areas of the tapered pocket on the imported solid 
model. 

1 Choose a New Color.      

2 Choose New Surface Group from the Part Features menu. The Surface 
Group Parameters dialog will display.  

3 Uncheck the Roughing box and make sure Finishing is checked. 

4 Tool diameter should be already set to 0.25 (6.35).  

5 Click the <Select Tools> button and make sure Tool Type is set to End 
Mill. Click <Select> to choose the tool T010 1/4 Ball Mill and return to 
Surface Group Parameters dialog. 

 
6 From the Strategy drop down menu choose Steep and Shallow 

Finishing as shown below. 

 
7 Enter “Finish Pocket” in the Group Name field. Press the <Enter> key 

or click the <Apply> button. 
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8 Click the <Options> button next to Strategy drop down menu to 
display the Steep and shallow finishing dialog. 

9 Set the Order using the drop down menu to Steep first with zero 
Additional stock. The Order determines the machining order of shallow 
and steep areas in the pocket. 

10 Set the Threshold angle to 30 degrees and the Steep and shallow 
overlap to 0.125 (3.175). 

11 Set the value of Stepdown under Steep group to 0.02 (0.508). 

12 Set the value of Stepover under Shallow group to 0.015 (0.381). 

13 Check Spiral toolpath for the Steep group as shown below. 

14 Under Shallow group, choose 3D offset for Type and check Smoothing. 

 
15 Click <OK> to return to the Surface Group Parameters dialog 
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Select Surfaces for Machining 
At this point you should still have the Surface Group Parameters dialog open. 
In the lower left hand corner of this dialog there is a framed section called 
Toolpath Settings. In this section you will control how you select surfaces to 
be machined by the current operation. There are two choices: Machine All 
Surfaces and Machine Selected Surfaces. 

Make sure the Machine All Surfaces radio button is checked. As a result you 
will have selected every surface of the part to be machined.  

Your dialog should appear as below, where the number of Selected Surfaces is 
69. 

 
Click on the <Close> button in Surface Group Parameters dialog to return to 
the Face Window. 
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Create a Boundary Curve 
Boundary curves are created the same way as 2D profile curves. They are used 
as tool path boundaries to restrict machining area.  

1 From the Face Window tool bar choose Show Holes and Profiles for 
Workgroup Only to enter the mode for showing the boundary curves in 
just the selected group.  

2 Choose the Chain Geometry on Solid Model icon 

3 Double click on any of the orange points of the tapered pocket as you did 
in the previous section. 

4 From the Face Window tool bar click back on the Show Holes and 
Profiles for Workgroup Only button to return to mode where you can 
see the tool path profiles for all of your groups.  

Verify the Tool Path 
Once you have created the Part Feature and established a Boundary Curve 
you can visually verify the tool path PartMaker has calculated. To do so: 

1 From the Face Window tool bar choose Verify Work Group Tool path.  

2 Uncheck the Enable Verification on Face Window. As we are only 
working on the solid, we do not need to see the verification in 2D. 

3 Enter a Verification Delay of 0. 

Note: When entering a Verification Delay of greater than 0, you will see a 
3D representation of the cutting tool moving along the Solid Model.  When 
Verification Delay is set to 0, you will only see the path of the tool on the 
Solid Model. 
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4 Click <OK> to show the calculated tool path. Your screen should appear 
as shown below: 

 
5 To hide toolpath, from the Face Window tool bar click on Hide Every 

Tool path.  

Lock the Tool Path 
As you did in the previous step, once you are satisfied with the verified tool 
path, you should now lock the tool path. To do so: 

1 Double click on the feature in the Job Explorer tree 

2 Click the Lock Toolpath check box in Surface Group Parameters dialog 

3 Click the <Close> button to close the Surface Group Parameters dialog 
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Define Surface Machining Strategies for the Side Cavity 
In this section of the tutorial you will create, bound and verify a toolpath for 
roughing, finishing and remachining of the side cavity with the rounded bottom.  In 
this section, roughing, finishing and remachining will be done using only one Part 
Feature.   

1 Choose a New Color.      

2 Choose New Surface Group from the Face Window tool bar to display 
the Surface Group Parameters dialog.  

3 Check the Finishing and Remachining radio button. Make sure that 
Roughing is still checked. 

4 Enter a tool diameter of .25 (6.35) for Roughing, Finishing, and 
Remachining operations. 

5 Click the <Select Tools> button. 

Select T010 1/4 Ball Mill for Roughing operation by clicking <Select> 
button as shown below. 

 
Upon clicking <Select> button, the dialog box closes and reopens for 
Finishing operation as shown below. Select the tool T010 1/4 Ball Mill for 
Finishing and click <Select> button. 
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The Select Tool dialog closes and reopens for the Remachining operation, 
click on T010 1/4 Ball Mill tool and click <Select> button as shown below. 
You will return to Surface Group Parameters dialog. 

 
6 From the Strategy drop down menu for Finishing choose Steep and 

Shallow Finishing. 

7 From the Strategy drop down menu for Remachining choose Corner 
Finishing. 

8 In the Cycle Name field enter “Side Cavity”.  Press the <Enter> key or 
click the <Apply> button. 
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9 Click the <Options> button next to the Model Area Clearance strategy 
to display the Surface Machining Options dialog as shown below. 

 
10 Change the Style to Raster and set the Thickness value to 0.02 

(0.508). 

11 Click <OK> to return to the Surface Group Parameters dialog. 

12 Click the <Options> button next to Steep and Shallow Finishing strategy 
to display the Surface Machining Options dialog as shown below. 

13 Set the value of Stepdown under Steep group to 0.02 (0.508). 

14 Set the value of Stepover under Shallow group to 0.015 (0.381). 

15 Under Steep group, check Spiral option. For the Shallow group, check 
Spiral and Smoothing options. 

 



 

Copyright @2014 Delcam Ltd  User Guide 1-31  

 

16 Click <OK> to return to the Surface Group Parameters dialog. 

17 Click the <Options> button next to Corner Finishing strategy to 
display the Surface Machining Options dialog as shown to the right. 

 
18 In the left panel of the dialog, click on Corner detection item under 

Corner finishing tree. 

19 Note the reference tool icon. This shows the tool being referenced for the 
remachining. 

20 Since you are using the same sized tool for remachining as you are for 
roughing and finishing, you will need to specify and overlap. Enter an 
overlap 0.1 

 
21 Click <OK> to return to the Surface Group Parameters dialog. 
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Select Surfaces for Machining 
At this point you should still have the Surface Group Parameters dialog open. 
In the lower left hand corner of this dialog there is a framed section called 
Toolpath Settings. In this section you will control how you select surfaces to 
be machined by the current operation. There are two choices: Machine All 
Surfaces and Machine Selected Surfaces. 

Make sure the Machine All Surfaces radio button is checked. As a result you 
will have selected every surface of the part to be machined.  

Your dialog should appear as below where the number of Selected Surfaces is 
69. 

 

Click on the <Close> button in Surface Group Parameters dialog to return to 
the Face Window. 

Create a Boundary Curve 
Boundary curves are created the same way as 2D profile curves. They are used 
as tool path boundaries to restrict machining area.  

1 Choose the Chain Geometry on Solid Model icon 

2 Double click on any of the orange points of the side cavity as you did in 
the previous section. 
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Verify the Tool Path 
Once you have created the Part Feature and established a Boundary Curve 
you visually verify the tool path PartMaker has calculated. To do so: 

1 From the Face Window tool bar choose Verify Work Group Tool path.  

2 Uncheck the Enable Verification on Face Window. As we are only 
working on the solid, we do not need to see the verification in 2D. 

3 Enter a Verification Delay of 0. 

Note: When entering a Verification Delay of greater than 0, you will see a 
3D representation of the cutting tool moving along the Solid Model.  When 
Verification Delay is set to 0, you will only see the path of the tool on the 
Solid Model. 
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4 Click <OK> to show the calculated tool path. Your screen should appear 
as shown below: 

 
5 To hide toolpath, from the Face Window tool bar click on Hide Every 

Tool path.  

Lock the Tool Path 
As you did in the previous step, once you are satisfied with the verified tool 
path, you should now lock the tool path. To do so: 

1 Double click on the feature in the Job Explorer tree 

2 Click the Lock Toolpath check box in Surface Group Parameters dialog 

3 Click the <Close> button to close the Surface Group Parameters 
dialog 
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Surface Machining Strategies for the Center Cavity 
In this section of the tutorial you will create a roughing operation using Model Area 
Clearance strategy and a finishing operation using Spiral Finishing strategy for the 
circular cavity in the middle of the part. Both, roughing and finishing operations will 
be done using only one Part Feature 

1 Choose a New Color.      

2 Choose New Surface Group from the Part Features menu. The Surface 
Group Parameters dialog will open.  

3 Check the Finishing radio button. Make sure that Roughing is still 
checked. 

4 Enter tool diameter of 0.25 (6.35) for Roughing and Finishing 
operations.  

5 Click the <Select Tools> button. 

Select T010 1/4 Ball Mill for Roughing operation by clicking <Select> 
button as shown below. 

 
Upon clicking <Select> button, the dialog box closes and reopens for 
Finishing operation as shown below. Select the tool T010 1/4 Ball Mill for 
Finishing and click <Select> button to return to Surface Group 
Parameters dialog. 

 
6 In the Surface Group Parameters dialog, choose Spiral Finishing 

from the Strategy drop down menu. 

7 In the Group Name field enter “Center Cavity”.  Press the <Enter> key 
or click the <Apply> button. 
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8 Click the <Options> button next to the Model Area Clearance strategy 
to display the Surface Machining Options dialog as shown to the right. 

9 Change the Style to Offset All and set the Thickness value to 0.01 
(0.254). 

 
10 Click <OK> to return to the Surface Group Parameters dialog. 

11 Click the <Options> button next to Spiral Finishing strategy to display 
the Surface Machining Options dialog as shown to the right. 

12 Set the value of Stepover to 0.015 (0.381). 

13 Make sure the Thickness value is set to zero. 

 
14 Click <OK> to return to the Surface Group Parameters dialog. 
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Different Types of Surfaces in ASM 
ASM allows you to select a few different types of surfaces, including: 

 Machining Surface – A surface that will be machined with a surfacing tool 
path 

 Hole Surface – A hole that will machined in another process, typically some 
sort of hole making (i.e. drilling) or 2D milling operation. 

 Collision - A surface that will not be machined, but must be avoided (for 
example, a clamp).  

 Ignore - A surface that will not be machined and was created only for 
construction purposes. 

In this section, we will create both a Machining surface and a Hole surface 

Select Surfaces for Machining 
At this point you should still have the Surface Group Parameters dialog open. 
In the lower left hand corner of this dialog there is a framed section called 
Toolpath Settings. In this section you will control how you select surfaces to 
be machined by the current operation. There are two choices: Machine All 
Surfaces and Machine Selected Surfaces. 

Make sure the Machine All Surfaces radio button is checked. As a result you 
will have selected every surface of the part to be machined.  

Your dialog should appear as below, where the number of Selected Surfaces is 
69. 
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Select a Hole Surface 
In the case of the center cavity, there is a small drilled hole at the bottom. We 
want to make sure our end mill does not go into this hole. In order to avoid 
having the tool defined in this feature go into the hole, we are going to define 
this as a Hole Surface.  To do so: 

1 In the Surface Group Parameters dialog, choose the Hole Surface 
from the Surface Type drop down as show here: 

 
2 Select the hole at the bottom of the center cavity by clicking on it with 

your left mouse button as shown below:  

 
3 Click on the <Close> button in Surface Group Parameters dialog to 

return to the Face Window. 
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Create a Boundary Curve 
Boundary curves are created the same way as 2D profile curves. They are used 
as tool path boundaries to restrict machining area.  

1 Choose the Chain Geometry on Solid Model icon 

2 Double click on any of the orange points of the side cavity as you did in 
the previous section. 

 

Verify the Tool Path 
Once you have created the Part Feature and established a Boundary Curve 
you visually verify the tool path PartMaker has calculated. To do so: 

1 From the Face Window tool bar choose Verify Work Group Tool path.  

2 Uncheck the Enable Verification on Face Window. As we are only 
working on the solid, we do not need to see the verification in 2D. 

3 Enter a Verification Delay of 0. 

Note: When entering a Verification Delay of greater than 0, you will see a 
3D representation of the cutting tool moving along the Solid Model.  When 
Verification Delay is set to 0, you will only see the path of the tool on the 
Solid Model. 

 



 

1-40 PartMaker  Copyright @2014 Delcam Ltd 

 

4 Click <OK> to show the calculated tool path. Your screen should appear 
as shown below:  

 
5 From the Face Window tool bar choose Hide Every Tool Path.  

Lock Toolpaths 
As you did in the previous step, once you are satisfied with the verified tool 
path, you should now lock the tool path. To do so: 

1 Double click on the feature in the Job Explorer tree 

2 Click the Lock Toolpath check box in Surface Group Parameters dialog 

3 Click the <Close> button to close the Surface Group Parameters dialog 
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Define Profiles for Contour Mill Cycle 
In this section of the tutorial you will mill the outside of the part using a 2 ½ axis 
milling feature 

1 Choose a New Color.     

2 Choose New Profile Group from the Part Features menu to display the 
Profile Group Parameters dialog.  

3 Choose Contour Mill from the Strategy drop down menu. 

4 Choose Left from the Tool Position drop down menu.  

5 Enter 0.5 (12.7) in the Diam (d) field. 

6 Click the <Select Tools> button. 

7 From the Select Tool dialog, click on the End Mill_1/2 and click the 
<Select> button 

8 Click the Extract Parameters from Solid box 

9 Select the side of the part as shown below. Once selected, it will be 
highlighted in red. 

 
10 Click the <Extract> button and the machining Z_Depth will be 

populated automatically. 

11 Enter “Mill Sides” in the Group Name field. Press <Enter> on your 
keyboard or click <Apply>. 
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When you are finished your dialog should appear as shown below: 

 
12 Click the <Close> button. 

Create Profiles Using Chain Geometry Icon 

1 Select the Chain Geometry on Solid Model icon on the left side of the 
Face Window.  

2 Double click on the location marked “1” in the following illustration. A 
profile is automatically created. 

 
Note: The profile shows direction arrows. This means it is selected and can be 
reversed, translated or rotated. 
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Verify the Tool Path 
1 From the Face Window tool bar choose Verify Work Group Tool path.  

2 Uncheck the Enable Verification on Face Window. As we are only 
working on the solid, we do not need to see the verification in 2D. 

3 Enter a Verification Delay of 0. 

Note: When entering a Verification Delay of greater than 0, you will see a 
3D representation of the cutting tool moving along the Solid Model.  When 
Verification Delay is set to 0, you will only see the path of the tool on the 
Solid Model. 
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4 Click <OK> to show the calculated tool path. Your screen should appear 
as shown below: 

 
5 To hide toolpath, from the Face Window tool bar click on Hide Every 

Tool path.  
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Drill a Hole in the Center Cavity 
In this section of the tutorial you will drill the hole in the center cavity 

1 Choose New Color.      

2 Choose New Hole Group from the Part Features menu to display the 
Hole Group Parameters dialog.  

3 Leave the Through Hole box checked. 

4 Leave the Type drop down menu set to Drill. 

5 Leave the Diameter (d) field set to 0.25 (6.35). 

6 Click on the “Extract Parameters from Solid” check box. 

7 Click on the Solid Model inside the hole in Center Cavity.  

8 Click on the “Extract” button and select the Drill-1/4 (Drill_6.35) cycle.  

9 In the Select Cycle dialog click the <Select> button to choose selected 
cycle 

 
10 The Hole Group Parameters dialog has been filled in using information 

from the solid model.  

11 Click the <Close> button to close the Hole Group Parameters dialog. 

12 Choose the Single Hole on Solid Model icon and click on the .25 (6.35) 
inch drilled hole in the middle of the part.  
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Your screen should now appear as shown below: 
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Generate a Process Table  
The process table shows you all of the processes for a part. Before generating a 
process table, you can choose to reorder processes automatically to minimize tool 
change time and optimize machining. 

When PartMaker generates a process table, all cutting conditions such as feed rate 
and spindle speed RPM are calculated automatically based on the tools and material 
information.  

1 Choose Generate Process Table from the Main tool bar to display the 
Process Table Options dialog as below: 

 
2 Click <OK> to display the Process Table window as shown below. 

 
Note: If tool numbers are not in the proper order, you can choose 
Renumber Tools from the Job Optimizer menu to automatically renumber 
the tools before generating an NC part program. 
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Simulate the Cutting Process 
Once you are satisfied with the appearance of your Process Table you can simulate 
cutting. To do so: 

1 From the Process Table, click the <Simulation> button in the lower left 
hand corner of the Process Table or just press the <Space Bar>.  

2  When the Simulation window appears, press the <Space Bar> or 
choose Start Simulation from the Simulate menu to initiate 3D 
simulation.  Your completed part should appear as shown below:  
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Generate an NC Program 
1 Choose Post Config File= ? From the Job Optimizer menu to display the Open 

Post Configuration File dialog.  

2 Locate and double-click the Postlib folder to open the Post Configuration file. 

3 Select the DEMO.PST post processor. 

4 Click the <Open> button to load the DEMO.PST. 

 

 Note: If you use the same .PST file all the time, move it from POSTLIB 
(the postprocessor library) to your working directory/folder where it will 
be loaded automatically when you generate an NC program. 

5 Click on Generate NC-Program icon from the Main tool bar to display the 
Save NC Program dialog. When you generate an NC Program for the first time 
during a programming session the Post Options dialog is displayed before the 
Save NC Program dialog.  

 
6 Choose the Post Options you prefer. If you leave Block Increment at zero there 

will be no sequence numbers in your part program. 
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7 Click <OK> to proceed to the Save NC Program dialog: 

 
8  Enter the name smwpractice.TXT for the NC program. 

9 Click <Save> to generate the NC Program. 

NC Program generated is shown below. 
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Chapter 2: Creating a Sample Part using 
PartMaker Advanced Surface Machining 
(ASM) for SwissCAM and Turn-Mill 
Introduction 

This tutorial is designed to help you learn the steps to go through in using 
PartMaker SwissCAM or PartMaker Turn-Mill to program parts on a lathe utilizing 
PartMaker’s Advanced Surface Machining. This tutorial assumes that you have a 
good working knowledge of either PartMaker SwissCAM or Turn-Mill.  Though the 
PartMaker SwissCAM module is used for this tutorial, the steps can be identically 
replicated if working in PartMaker Turn-Mill. 

This tutorial has been developed for use with PartMaker Versions 2013 and higher. 

How You Will Create the Sample Part 
Below are the major concepts that will be covered in this tutorial. 

 
 Solid Model Importing 

 Establishing part boundaries from a Solid Model 

 Transferring Geometry from a Solid Model 

 Opening Tools, Cycles and Material files 

 Performing Turning operations in the context of surface machining 

 Creating Surface Finishing tool paths on the face of the part 

 Creating Surface Projection tool paths on the face of the part 

 Creating Surface Finishing tool paths on the outside diameter of the part 

 Duplicating identical face windows 

 Creating a cross hole 

 Chamfering a cross hole using a Surface Projection Machining Strategy 
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Start PartMaker 
1 Double click the PartMaker SwissCAM icon (or PartMaker Turn-Mill icon if using 

PartMaker Turn-Mill) on your Windows desktop. 

2 When PartMaker launches, the Setup dialog will open as shown below:  

 
3 Click <Close> to close the Setup dialog. 
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Set Defaults 
Before getting started with this tutorial, it is important to set the correct defaults. 
Doing so is explained below: 

Defaults for Turning (SwissCAM users) 
If you are using PartMaker SwissCAM to complete the steps of this tutorial, please 
read below. If you are using PartMaker Turn-Mill please skip to the next section 
called Defaults for Turning (SwissCAM users): 

1 From Job Optimizer menu choose the Defaults command. You will be 
prompted with the dialog below: 

 
2 Click the <Turning> button to enter the Defaults of Turning dialog. 

3 In the Input Options section of the Defaults for Turning dialog, check the 
Diameter Programming box (see below) 

4 In the Input Options section of the Defaults for Turning dialog, make 
sure to uncheck the Positive Z Programming box as shown below: 

 
5 Click the <OK> button to close the Defaults for Turning dialog. 
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Defaults for Turning (Turn-Mill users) 
If you are using PartMaker Turn-Mill to complete the steps of this tutorial, please 
read below. If you are using PartMaker SwissCAM please refer to the previous 
section called Defaults for Turning (SwissCAM users): 

1 From Job Optimizer menu choose the Defaults command. You will be 
prompted with the dialog below: 

 
2 Click the <Turning> button to enter the Defaults of Turning dialog. 

3 In the Input Options section of the Defaults for Turning dialog, check the 
Diameter Programming box (see below) 

 
4 Click the <OK> button to close the Defaults for Turning dialog. 
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Defaults for Milling (SwissCAM and Turn-Mill users) 
Both PartMaker Turn-Mill and SwissCAM users will be prompted with identical 
dialogs for setting default parameters for milling. To view these parameters: 

1 From Job Optimizer menu choose the Defaults command. You will be 
prompted with the dialog below: 

 
2 Click the <Milling> button to enter the Defaults of Milling dialog. 

3 Make sure ASM Radio button is selected under Surface Machining Module to 
use ASM. 

 
4 Click the <Surfacing Defaults> button in the Defaults for Milling dialog. 

The Surfacing Defaults dialog will display as shown below. 
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Importing the Solid Model 
1 From the File menu choose the Import submenu as shown below:  

2 From the Import submenu choose the X_T Parasolid Transmit Text File… 
command.  

3 Open the Parasolid file at the following directory path:  

a If you are using PartMaker SwissCAM: 

C:\PartMaker_2014\pm-swiss\ASM_Surface_Machining\Tutorial_ASM 
\ASM_Tutorial.X_T as shown below: 

 
b If you are using PartMaker Turn-Mill: 

C:\PartMaker\pm-tm\ASM_Surface_Machining\Tutorial_ASM 
\ASM_Tutorial.X_T as shown below: 

 
4 Click the <Open> button to load the Solid Model into PartMaker.  
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Setting Part Boundaries from the Solid Model  
1 Double click on the OD of the Solid Model in the Solid Model window as shown 

below: 

 
2 Double clicking on this surface will display the Surface Info dialog as shown 

below: 

 
3 Take note of value of -2.6159 (-66.444) in the Z1 field in the Surface Info 

dialog.  This corresponds to the finished length of the part. 

4 Take note of value of .4747 (12.059) in the Radius field in the Surface Info 
dialog.  This corresponds to the largest radius of the part.  As a result, for 
purposes of this tutorial it will be assumed that you will start from 1” (25.00) 
diameter bar stock (as the largest diameter is twice the value of the parts 
largest radius, i.e. 2*.4747 or .9494 (12.059*2=24.118)  

5 Click the <Close> button to close the Surface Info dialog. 
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The Setup Dialog: SwissCAM Users 
If you are using PartMaker SwissCAM to complete the steps of this tutorial, please 
read below. If you are using PartMaker Turn-Mill please skip to the next section 
called The Setup Dialog: Turn-Mill Users: 

1 Choose Setup from the View menu. 

2 Enter 2.6159 (66.444) in the Length (L) field in the Setup dialog. 

3 The part will be made out of 1inch (25mm) bar stock. Enter 1(25) in the OD 
field of the Setup dialog. 

4 Enter .01 (2.0) in the Excess Stock (E) field of the Setup dialog. 

5 Click the <Apply> button. Your completed Setup dialog should appear as 
shown below: 

 
6 Click the <Close> button to close the Setup dialog. 
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The Setup Dialog: Turn-Mill Users 
If you are using PartMaker Turn-Mill to complete the steps of this tutorial, please 
read below. If you are using PartMaker SwissCAM please see the previous section 
called The Setup Dialog: SwissCAM Users: 

1 Choose Setup from the View menu 

2 Check the Use Bar Stock box 

3 Enter 2.6159 in the Length (L) field in the Setup dialog 

4 The part will be made out of 1inch bar stock. Enter 1 in the OD field of the 
Setup dialog. 

5 Enter .01 in the Excess Stock (E) field of the Setup dialog. 

6 Enter 3 in the Work Shift (l) field of the Setup dialog. 

7 Click the <Apply> button. Your completed Setup dialog should appear as 
shown below: 

 
8 Click the <Close> button to close the Setup dialog. 
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Transferring Geometry from the Solid Model   
1 Use the CAD/CAM Switch icon to switch to CAD Mode.  

2 On the Solids Window toolbar click the Extract Turn Geometry icon. 

 
3 Set the “Turning Plan Angle” to 270 and click <OK> 

4 Click the <Convert Curves to Arcs> button and click <OK> as shown below: 
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5 Click anywhere in the CAD Face Window to deselect the geometry you have 
transferred. Your CAD Face Window should now appear as shown below: 

 
6 Use the CAD/CAM Switch icon to switch back to CAM Mode.  

Open Tools, Cycles and Material Files 
If you are using PartMaker SwissCAM: 

From the File menu choose Open Tools File and open 

C:\PartMaker\PM-Swiss\ASM_Surface_Machining\ 

Tutorial_ASM\ASM_Tutorial.tdb 

From the File menu choose Open Cycles File and open 

C:\PartMaker\PM-Swiss\ASM_Surface_Machining\ 

Tutorial_ASM\ASM_Tutorial.cdb 

From the File menu choose Open Material File and open 

C:\PartMaker\PM-Swiss\Material\Alu_allw.mdb 

 

If you are using PartMaker Turn-Mill: 

From the File menu choose Open Tools File and open 

C:\PartMaker\pm-tm\ASM_Surface_Machining\ 

Tutorial_ASM\ASM_Tutorial.tdb 

From the File menu choose Open Cycles File and open 

C:\PartMaker\PM-TM\ASM_Surface_Machining\ 

Tutorial_ASM\ASM_Tutorial.cdb 

From the File menu choose Open Material File and open 

C:\PartMaker\PM-TM\Material\Alu_allw.mdb 
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Creating a Facing Operation 
1 Choose New Profile Group from the Part Features menu.  

2 Leave the Strategy selection as Contouring 

3 From the Tool Location drop down menu, choose Face 

4 Uncheck the Roughing box so Finishing is checked. 

5 Click the <Select Tools> button.  

6 Choose T001 from the Select Tool dialog and click <OK> 

 
7 In the Group Name field, type “Face” and click the <Apply> button.  Your 

Profile Group Parameters dialog should appear as shown below: 

 
8 Click the <Close> button to return to the CAM Face Window. 
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Create the Profile for Facing 
Because you are facing off the part, PartMaker will create the profile automatically. 
Your face window should appear as shown below: 
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Creating the First OD Turning Operation 
1 Choose a New Color. 

To do so click a color square in the color bar at the top of the Face Window 
different from the Sample Color. 

 Important! Do not select a color that is the same as the background color 
of your Face Window. Doing so will make your profile difficult to see. 

 

2 Choose New Profile Group from the Part Features menu.  

3 Uncheck the Roughing box and Finishing will automatically be selected. 

4 Click the <Select Tools> button.  

5 Choose T001 from the Select Tool dialog and click <OK> 

 
6 In the Group Name field, type “1st Turn” and click the <Apply> button.  Your 

Profile Group Parameters dialog should appear as shown below: 

 
7 Click the <Close> button to return to the “Front” Face Window. 
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Create the Profile for OD Turning 
Now that you have created the part feature, you are ready to assign it to your part 
geometry to create a tool path. To do so: 

1 Choose the Profile icon from the graphics icons on the left side of the Face 
Window 

2 Click the Closest Intersection Snap Mode from the Snap Mode icons at the 
top of the screen 

Your cursor now appears as a small X.  Click on positions 1, 2, 3 and 4 
respectively as shown in the picture below to assign the tool path to the 
geometry. 

 
In this operation, you will only turn just past the first radius so there is 
adequate support for the milling operations. In the next operation, you will 
turn the rest of the part 

3 Click the Selection icon.  
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Creating the Second OD Turning Operation 
1 Choose a New Color.     

2 Choose New Profile Group from the Part Features menu. 

3 Uncheck the Roughing box so Finishing is checked. 

4 Click the <Select Tools> button.  

5 Choose T001 from the Select Tool dialog and click <OK> 

 
6 In the Group Name field, type “2nd Turn” and click the <Apply> button.  Your 

Profile Group Parameters dialog should appear as shown below: 

 
7 Click the <Close> button 
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Create the Profile for OD Turning 
Now that you have created the part feature, you are ready to assign it to your part 
geometry to create a tool path. To do so: 

1 Choose the Profile icon from the graphics icons on the left side of the Face 
Window 

2 Click the Closest Intersection Snap Mode from the Snap Mode icons at the 
top of the screen 

3 You cursor now appears as a small X.  Click on positions 1 and 2 respectively 
as shown in the picture below to assign the tool path to the geometry. 

 
4 Click the Selection icon to deselect the profile.  
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Creating a Cutoff Work Group 
1 Choose a New Color.   

2 Choose New Profile Group from the Part Features menu.  

3 From the Strategy drop menu, choose Cut-Off.   

4 Click the <Select Tools> button.  

5 Choose T004 from the Select Tools dialog and click <OK> 

 
6 In the Cycle Name field, type “Cut-Off” and click the <Apply> button.  Your 

Profile Group Parameters dialog should appear as shown below: 

 
7 Click the <Close> button to close the Profile Group Parameters dialog.  
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Create the Profile for the Cut-Off Operation 
Because you are cutting off the part, PartMaker will create the profile automatically. 
Your face window should appear as shown below: 

 

Save Your Work 
It is always a good idea to save your at various points in the part creation 
process in PartMaker. To do so: 

1 From the File menu choose Save or press <CTRL + S> on your keyboard 

2 Enter the name of your job.  Here, save your job file as asmpractice 

3 Click the <Save> button. 
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Creating Surface Projection Tool Paths on the Face of the Part  
In this section of the tutorial you will create, bound and verify surfacing tool paths 
for projection and finish machining on the face of the imported solid model using 
ASM. You will use this projection to rough away material for the finishing operation 
that will be made in the next section. 

 Important! Before moving on, make sure your Solid Model is set to Full 
View. If your Solid Model currently appears in a cross sectional view, click 
on it with your right mouse button and choose Full View from the drop 
down menu or select the Full View button on the Solids tool bar.  

 

Create a New Face Window for Surfacing on the Face 
The first step in creating a surfaced feature in PartMaker Turn-Mill or SwissCAM is to 
create a new Face Window.  In this case, you will use the Mill End Polar Face 
Window so you can use  
X, Z and C tool motion on the face of the part. To create the Face Window: 

1 Choose Setup from the View menu  

2 In the Setup dialog, click the <New> button to create a new Face Window 
which appear with the name “Untitled 2” 

3 From the Machining Function drop down menu, choose Mill End Polar.   

4 In the Rename To: field, type “Surface Face” and click <Apply>.  Your 
completed Setup dialog should appear as shown below: 

 
5 Click the <Close> button to close the Setup dialog. 
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Create a New Surface Group for Projection Machining 
In this section of the tutorial you will create, bound and verify a tool path for 
projection machining on the face of the imported solid model. Projection machining 
allows you to “project” a pattern curve onto a 3D surface.  In this example, the 
projection tool path will be used to “rough” away material for the finishing tool 
paths to be created in the next section. 

1 Choose New Surface Group from the Part Features menu. The Surface Group 
Parameters dialog will display.  

2 Check the Projection check box. 

3 Uncheck the Roughing check box. 

4 Enter a tool diameter of 0.3 in (7.6 mm) in the Diam (d) field and click the 
<Select Tools> button. 

5 In the Group Name field enter “Pattern Finishing” and click <Apply>. 
The dialog should now appear as shown below: 
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Establishing the Tool’s Approach to the Stock 
When machining this projection feature, it will be necessary to have the tool 
correctly approach the part to avoid a collision between the tool and the stock.  
To do so, click the <Options> button in the Surface Group Parameters dialog 
which will open the dialog for the Pattern Finishing strategy as shown below in 
the picture. 

 
This will open the Pattern Finishing strategy dialog 

 
1 Click the Leads and Links tab in the tree on the left in the Pattern 

finishing dialog to expand the Lead and Links features. 
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2 Click on Lead in the tree to see the lead-in options.  

 
3 Set Type to Straight 

 
4 The Distance field would now be enabled. Enter a value of 1 (25 mm) in the 

distance field. 

 

5 Click on  to copy the same parameters from Lead In to Lead Out. 
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General Pattern Finishing Settings 
1 In the Pattern finishing dialog, on the main page enter the Tolerance value of 

0.005 (0.125 for metric) as shown below 

 
2 In the Pattern Finishing dialog click on Limit tab to see the toolpath limit 

parameters as shown below. 

 
3 Make sure the Limit Tool option is set to Past block to allow the tool to 

move outside the block in order to follow the pattern. 

4 Click the <OK> button to close the Pattern Finishing strategy dialog and 
return to the Surface Group Parameters dialog 
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Select the Surfaces for Machining 
At this point you should still have the Surface Group Parameters dialog open. 
In the lower left hand corner of this dialog there is a framed section called 
Toolpath Settings. In this section you will control how you select surfaces to 
be machined by the current operation. There are two choices: Machine All 
Surfaces and Machine Selected Surfaces. By default Machine All Surfaces 
will be selected which will select all surfaces of the imported solid model as 
Machining Surfaces. 

In this case, you will select only the surfaces you wish to machine, i.e. you will 
select the surfaces manually. To do so:  

1 Click the Machine Selected Surfaces radio button in the Toolpath 
Settings section of the Surface Group Parameters dialog as shown below: 

 
2 The type of the surface you would be selecting can be changed from the 

Surface Type combo box in the Surface Selection section as shown in 
figure below: 

 
3 For current operation you need to select Machining Surface which would be 

selected by default. 

4 Click on the Clear Selection button in the Surface Selection section to 
clear the selected surfaces from the solid model. As you click on the Clear 
Selection button, the Selected Surfaces will show the current number of 
surfaces selected for the current surface type selected in the Surface Type 
combo box as shown below:  
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5 In the Solid Model File window, click on the base of the boss and the 
surface adjacent to it as indicated in the picture below: 

 
The Selected Surfaces text in the Surface Group Parameters dialog 
should display the value 2. 

6 Now select ignore surfaces of the model so that the toolpath can follow the 
pattern without detecting gouging with the solid model. Select Ignore 
Surfaces in Surface Type combo box. 

Select the surfaces as shown below as ignore surfaces 

 
7 Click the <Close> button to return to the CAM Face Window. 
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Create Surface Machining Pattern Curve 
Pattern curves are created the same way as 2D profile curves. Pattern curves are 
2D/3D profiles that are projected onto a 3D surface in order to calculate a tool path. 

To create a pattern curve for the feature defined in this section: 

1 Click the CAD/CAM switch to enter the CAD mode.  

2 Double click on the face of the solid model as indicated below to open the 
Surface Info dialog.  

 
3 Click the <Transfer Planar Geometry > button in the Surface Info dialog 

shown below to transfer the boss’s profile into the CAD Face Window.   

 
The circle you have just transferred should now be highlighted indicating that it is 
selected.  If it is not highlighted, select it by clicking on it so that it is highlighted. 

 
4 Click anywhere in the Face Window to deselect the geometry. 

5 Switch to the CAM mode.  

6 Choose the Chain Geometry icon  

7 Click your cursor at the 9 o’clock position on the circle as indicated below to 
apply the pattern curve to the geometry.  
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Your Face Window should now appear as shown below: 

 
8 Double click on the pattern curve using the Selection icon to display the 

Curve Properties dialog below.  

9 The direction of the arrows on the projection curve will dictate the Tool 
Position you choose.  If the arrows are pointing in a counter clockwise 
manner, choose Right from the Tool Position drop down menu. If the 
arrows are pointing in a clockwise manner, choose Left from the Tool 
Position drop down menu. 

In the picture above, the directional arrows are pointing counter clockwise, 
hence Tool Position Right has been chosen as shown below: 

 
10 Click the <OK> button to return to the CAM Face Window. 
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Change Block Size to Contain the Pattern 
1 As we will be machining to the Right of the defined Pattern, we need to make 

sure that the Block size for the ASM group would contain the tool if it moves 
to the right of the Pattern. 

2 To increase the block size, open the Surface Group Parameters dialog by 
double clicking on the group in the Job Explorer. 

3 The dialog as shown below will open. Click on Define Block to open the 
Block dialog 

 
4 The block dialog is as shown below. Enter the value in Expansion field to 

increase the block in all directions by the value. The expansion value in this 
case would be half the diameter of the tool being used i.e. 0.3/2 = 0.15. 
Your Define Block dialog should look as below: 

 
5 Now click on <From Stock> button and then click the <Apply> button to 

apply the value defined in the Expansion field to the block and click the. 
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6 You would be able to see the increase in the block size as shown below in the 
Solids Window. You can see the block limits by choosing Show Block Limits 
from the Part Features menu.  

 
You can hide the block limits by choosing Hide Block Limits from the Job 
Optimizer menu 

7 Now click <OK> in the Define Block dialog to return to Surface Group 
Dialog and click on <Close> to close that dialog. 
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Verify the Tool Path 
Once you have created the Part Feature and established a Boundary Curve 
you can visually verify the tool path PartMaker has calculated. To do so: 

1 From the Part Features menu choose Verify Work Group Tool Path.  

2 In the Tool Path Verification Options click the Do not show tool radio 
button as shown below.  

3 Enter a Verification Delay of 0. 

Note: When entering a Verification Delay of greater than 0, you will see the 
3D representation of the cutting tool moving along the Solid Model.  When 
Verification Delay is set to 0, you will only see the path of the tool on the 
Solid Model. 

 
4 Click <OK> to show the calculated tool path. Your screen should appear as 

shown below: 

 
Note: Notice above, the line that extends into the programmed tool path.  
This line represents the 1-inch Lead In & Lead Out set in the Leads and 
Links property page.  Creating this line assures that the tool will safely 
approach the stock without risking a tool collision. 

5 From the Part Features menu choose Hide Work Group Tool Path.  
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Creating Surface Finishing Tool Paths on the Face of the Part  
In this section of the tutorial you will create, bound and verify surfacing tool paths 
for finish machining on the face of the imported solid model. The finishing 
operations will be created in the same Face Window as the projection features 
created in the previous.  As a result, it is not necessary to create a new Face 
Window. 

Create a New Surface Group for Finishing 
In this section of the tutorial you will create, bound and verify a tool path for finish 
machining on the face of the imported solid model. 

1 Choose a New Color.      

2 Choose New Surface Group from the Part Features menu. The Surface Group 
Parameters dialog will display.  

3 Uncheck the Roughing radio button and make sure Finishing is checked. 

4 Enter a tool diameter of 0.3 (7.6) in the Diam (d) field and click the 
<Select Tools> button. 

5 From the Strategy drop down menu choose 3D Offset Finishing. 

6 In the Group Name field enter “Offset” and click <Apply>. Your completed 
dialog should appear as shown below: 
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7 Click the <Options> button to display 3D Offset Finishing dialog as shown 
below: 

 
8 Enter 0.05 (1.25 MM) in the Stepover field. 

9 Go to Limit tab and change Limit tool to Past Block in Block section to 
allow the tool outside the block 

 
10 Click the <OK> button to return to the Surface Group Parameters dialog. 

Select Surfaces for Machining 
At this point you should still have the Surface Group Parameters dialog open. 
Make sure Machine All Surfaces is selected in the Toolpath Settings section 
which sets all surfaces of the solid to machine surfaces. 

Click the <Close> button to close the Surface Group Parameters dialog. 
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Create Boundary Curves 

Boundary curves are created the same way as 2D profile curves. They are used as 
tool path boundaries to restrict the machining area. In this example, you will create 
two boundary curves.  

To create the boundary curves for this feature: 

1 Click the CAD/CAM switch to enter the CAD mode.  

2 Double click on the face of the solid model as indicated below to open the 
Surface Info dialog. 
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3 Click the <Project Outline > button in the Surface Info dialog shown 
below to transfer the boss’s profile into the CAD Face Window. 

 
4 Click the Convert Curved Edges to Arcs radio button 

 
5 Click anywhere in the Face Window to deselect the geometry. 

6 Switch to the CAM mode.  

7 Choose the Chain Geometry icon  
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8 Click your cursor on the outer profile just created as shown in the picture 
below to create a boundary curve for the toolpath. 

 
9 Double click on the selected curve to open the Curve Properties dialog.  

Select the Boundary Type as Contact Point as shown in figure below. For 
more information on boundary types, please refer help. 

 
10 Click the <OK> button to close the Curve Properties dialog. 
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Verify the Tool Path 
Once you have created the Part Feature and established a Boundary Curve 
you can visually verify the tool path PartMaker has calculated. To do so: 

1 From the Part Features menu choose Verify Work Group Tool Path.  

2 In the Tool Path Verification Options click the Do not show tool radio 
button as shown below.  

3 Enter a Verification Delay of 0. 

 
4 Click <OK> to show the calculated tool path. Your screen should appear as 

shown below: 
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5 From the Part Features menu choose Hide Work Group Tool Path.  

Note: You should always hide your tool path after verifying it.  

 Note: Whenever creating a surfacing tool path in ASM, it is always a good 
idea to “lock” the tool path once you are satisfied with result to avoid it being 
regenerated later. To “lock” a tool path, simply double click on the feature in 
the Job Explorer tree and click the Lock Toolpath button in Surface Group 
Parameters dialog. 

Once a tool path has been “locked” it will appear with a small lock next to it 
on the Feature Tree. 

As an exercise, go back and “lock” the first projection tool path you made.  Your 
Job Explorer tree should then appear as shown below: 
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Creating Surface Finishing Tool Paths on the Diameter of the 
Part  

In this section of the tutorial you will create, bound and verify a tool path for 
finishing operations on the outside diameter of the imported solid model. 

Create a New Face Window for Finish Machining on the Diameter 
The first step in creating the finish machining feature on the diameter is to create 
an appropriate Face Window.  In this case, you will use the Mill ZY Face Window to 
use a vertically oriented tool on the diameter of the part. To create the Face 
Window: 

1 Choose Setup from the View menu  

2 In the Setup dialog, click the New button to create a new Face Window 
which appear with the name “Untitled 3” 

3 From the Machining Function drop down menu, choose Mill ZY plane.   

4 In the Rename To: field, type “Mill OD” and click <Apply>.  Your completed 
Setup dialog should appear as shown below: 

 
5 Click <Close> to close the Setup dialog. 
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Create a New Surface Group for Finishing 
1 Choose New Surface Group from the Part Features menu. The Surface Group 

Parameters dialog will display. 

2 Uncheck the Roughing radio button and make sure Finishing is checked. 

3 Enter a tool diameter of 0.25 (6.0) in the Diam (d) field and click the 
<Select Tools> button. 

4 From the Strategy drop down menu choose Raster Finishing. 

5 In the Group Name field enter “Mill Sides” and click <Apply>. Your 
completed dialog should appear as shown below: 

 
6 Click the active <Options> button to display Raster Finishing dialog. 

7 Enter 0.05 (.50) in the Stepover field. 

8 Select the Ordering Style as Two Way. 

Your completed Raster Finishing dialog should appear as shown below: 
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9 Click on the Limit tab and select Limit Tool under Block section to Past 
Block 

10 Click on the Leads and Links tab and select Links from the tree. 

11 Choose the Short link to be On Surface as shown in figure below: 

 
12 Click <OK> to close the Raster Finishing dialog. 

Select Surfaces for Machining 
PartMaker’s ASM makes it very easy to select just the surfaces you wish to 
machine. To do so: 

1 Click the Machine Selected Surfaces radio button in the Surface Group 
Parameters dialog 

2 Click the <Clear Selection> button to clear the currently selected surfaces 

3 Move the Surface Group Parameters dialog out of the way and position 
the solid so you can see the surfaces you wish to select 

4 To assure you select the correct surfaces, click the Set View icon from the 
solids icon toolbar at the bottom of the screen and choose the ZX View as 
shown below: 
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5 Hold the <Shift> key down on your keyboard while depressing the left 
mouse button  

 
and drag a box from the upper right side of the surfaces to the lower left side 
of the surfaces and they will be highlighted blue as shown below: 

 
6 Click the <Apply> button and you will see the exact number of surface you 

have selected. You should have 11 surfaces selected. Your Surface Group 
Parameters dialog should appear as shown below: 

 
Note: If you have more than 11 surfaces selected, you have probably 
selected more surfaces than you wanted.  You can tell a surface is selected 
because it is highlighted in blue. You can easily deselect a surface by just 
clicking the extra surface. 

7 Click the <Close> to close the Surface Group Parameters dialog.   
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Verify the Tool Path 
Once you have created the Part Feature selected the surfaces to machine,m 
you can visually verify the tool path PartMaker has calculated. To do so: 

1 From the Part Features menu choose Verify Work Group Tool Path.  

2 In the Tool Path Verification Options click the Do not show tool radio button 
Enter a Verification Delay of 0. 

3 Click <OK> to show the calculated tool path. Your screen should appear as 
shown below after the tool path has been calculated: 

 
4  From the Part Features menu choose Hide Work Group Tool Path.  

5 As before, you should now “lock” your tool path by opening the Surface 
Group Parameters dialog and clicking the “Lock Toolpath” button 
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Duplicating Identical Face Windows 
Having programmed the finishing operation on one side of the outside diameter of 
the part, you now need to create the same feature on the other side of the part, i.e. 
180 degrees apart.  Instead of having to go through the process of recreating the 
feature in a new window, you can automatically duplicate it. To do so:  

1 Choose Setup from the View menu. 

2 In the Setup dialog, select the window called “Mill OD” as shown below (it 
should already be selected). 

 
3 Click the <Duplicate> button. 

4 In the Duplicate Face dialog, enter 1 in the Number of Copies field and 
180 in the C Angle Increment field. The completed dialog should appear as 
shown below: 

 
If the “Insert Into List of Faces” box is checked, then PartMaker will 
permanently insert new faces into list of faces. If this button is not checked 
then PartMaker will apply that number of copies and index increment angle 
on the Process Table. The process with duplicate copies will have a special 
icon next to the face name. Leave the “Insert Into List of Faces” box 
unchecked. 
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5 Click the <OK> button in the Duplicate Face dialog.  Your completed 
Setup dialog should appear as shown below: 

 
Notice the name of the Mill OD Face Window has (1,180) appended to it, this 
corresponds to the number of copies and index angle increment.  

6 Click the <Close> button to close the Setup dialog. 
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Creating a Chamfered Cross Hole 

Method 1: When the Solid Model already has a Chamfer 
In this section of the tutorial you will create a cross hole and create a uniform 
chamfer on that cross hole using a Projection surface machining strategy.  The steps 
explained below are to be used when the solid model being machine already has a 
chamfer defined on it. 

Create a New Face Window for Projection Machining on the Diameter 
The first step in creating the chamfered cross-hole on the diameter is to create 
an appropriate Face Window.  In this case, you will use the Mill ZY Face Window 
to use a vertically (i.e. X) oriented tool on the diameter of the part. To create 
the Face Window: 

1 Choose Setup from the View menu  

2 In the Setup dialog, click the New button to create a new Face Window 
which appears with the name “Untitled 5” 

3 From the Machining Function drop down menu, choose Mill ZY plane (it 
should already be selected) 

4 Enter 90 in the Angle (C) field.  Doing so will index the spindle to 90 
degrees when creating the cross hole and the chamfer. 

5 In the Rename To: field, type “Cross Hole Chamfer” and click <Apply>.  
Your completed Setup dialog should appear as shown below:  

 
6 Click the <Close> button to go to the new Face Window you have just 

created. 
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Create a Drilled Cross Hole 
1 Choose New Hole Group from the Part Features menu to display the Hole 

Group Parameters dialog.  

Here you will be making a through hole, so make sure to leave the Through 
Hole box checked 

2 Choose Drill from the Type drop down menu. 

3 Check the Extract Parameters from Solid box 

4 Select the hole surface you wish to drill. The hole surface will turn red once 
you do so. 

 
5 Once the hole is selected, click the <Extract> button 

6 From the Select Cycle dialog, choose the Drill_0.4376 Cycle and click the 
<Select> button. Your completed Hole Group Parameters dialog should 
appear as shown below. 

 
7 To verify the hole shape, click the <Verify Shape> button.  The dialog 

below will display. 
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8 click the <Hide Shape> button under the picture to hide the hole shape and 
return to the Hole Group Parameters dialog. 

 
9 Click the <Close> button in the Hole Group Parameters dialog to return 

to the Face Window. 

Assign the Hole Feature 
To assign the hole feature:  

1 Click the Single Hole on Solid Model icon  

2 Click the arrow head of your cursor approximately in the middle of the hole 
to be drilled on the solid model 

3 Click the Selection icon and click anywhere the Face Window away from 
hole profile to deselect the hole 
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Create a New Surface Group for Projection Machining 
Now that you have drilled the cross hole, you are ready to use a Projection 
machining strategy to chamfer this cross hole.  To do so: 

1 Choose a New Color.     

2 Choose New Surface Group from the Part Features menu. The Surface Group 
Parameters dialog will display.  

3 Check the Projection check box. 

4 Uncheck the Roughing check box. 

5 Enter a tool diameter of 0.25 (6.0) in the Diam (d) field. 

6 Here you will use a Spot Drill to create the feature.   

7 Click the <Select Tools> button. From the <Tool Type> drop down menu 
select Spot Drill. 

 
8 Click the <Select> button to select this tool. 

9 In the Group Name field enter “Chamfer” and click <Apply>. The dialog 
should now appear as shown below: 
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Select Surfaces for Machining 
At this point you should still have the Surface Group Parameters dialog open. 
Make sure Machine All Surfaces is selected in the Toolpath Settings section 
which sets all surfaces of the solid to machine surfaces. Click the <Close> 
button to return to the Face Window. Click the <Close> button to return to the 
Face Window.  

Click the <Close> button to return to the Face Window. 

Create Surface Machining Pattern Curves 
Pattern curves are created the same way as 2D profile curves. Pattern curves 
are 2D/3D profiles that are projected onto a 3D surface in order to calculate a 
tool path. 

To create a pattern curve for the feature defined in this section: 

1 In the 2D CAM Window, click on the Hole Feature created in the previous 
step so it is highlighted as shown here: 

 
2 With hole selected, from the Edit menu, choose Extract Geometry 

3 Make sure the Chamfer work group on the Job Explorer Tree is highlighted 

4 From the Face Window Toolbar, choose the Show Work Group Only icon. 
This will show just 2D curve of the chamfer 

5 Using the Chain Profile icon, click on the circular geometry  

With your cursor, double click on the profile curve you have just created to 
enter the Curve Properties dialog. Notice that Tool Position has defaulted 
to On.  When performing chamfering of a cross hole using a Projection 
Machining strategy, you should always leave Tool Position set to On so 
the tool machines directly on centerline along the Pattern Curve. 

6 Click <OK> to close the Curve Properties dialog.   
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Verify the Tool Path 
Once you have created the Part Feature and established a Projection Curve 
you can visually verify the tool path PartMaker has calculated. To do so: 

1 From the Part Features menu choose Verify Work Group Tool Path.  

2 In the Tool Path Verification Options click the Do not show tool radio  

3 Enter a Verification Delay of 0. 

Click <OK> to show the calculated tool path. Your screen should appear as 
shown below: 

 
Notice above that because the Solid Model is chamfered, the tool path was 
projected directly to diameter of the hole, thus automatically plunging the 
tool to the correct depth to create the chamfer.  As a result, it was not 
necessary to specify an Axial Thickness in the Pattern Finishing dialog of 
the Surface Group Parameters dialog.   

4 From the Part Features menu choose Hide Work Group Tool Path.  

As before, you should now “lock” your tool path by opening the Surface 
Group Parameters dialog and clicking the “Lock Toolpath” button 
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Method 2: When the Solid Model Does Not Have a Chamfer 
In this section of the tutorial you will create a uniform chamfer on the cross hole 
created in the previous section using a Projection surface machining strategy.  The 
steps explained below are to be used when the solid model being machined does 
not have a chamfer defined on it. 

Create a New Face Window for Projection Machining on the Diameter 
The first step in creating the chamfer on the diameter is to create an appropriate 
Face Window.  In this case, you will use the Mill ZY Face Window to use a 
vertically (i.e. X) oriented tool on the diameter of the part, 180 degrees apart 
from the previously created Face Window. To create the Face Window: 

1 Choose Setup from the View menu  

2 In the Setup dialog, click the New button to create a new Face Window 
which appears with the name “Untitled 6” 

3 From the Machining Function drop down menu, choose Mill ZY plane (it 
should already be selected) 

4 Enter 270 in the Angle (C) field.  Doing so will place the chamfer you are 
about to create 180 degrees apart from the chamfer created in the previous 
section. 

5 In the Rename To: field, type “Chamfer OD” and click <Apply>.  Your 
completed Setup dialog should appear as shown below:  

 
6 Click the <Close> button to go to the new Face Window you have just 

created. 
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Create a New Surface Group for Projection Machining 
Since you have already drilled a through cross hole, you are ready to use a 
Projection machining strategy to chamfer the hole.  To do so: 

1 Choose a New Color.     

2 Choose New Surface Group from the Part Features menu. The Surface Group 
Parameters dialog will display.  

3 Check the Projection check box. 

4 Uncheck the Roughing check box. 

5 Enter a tool diameter of 0.25 in the Diam (d) field. 

6 Here you will use a Spot Drill to create the feature.   

7 Click the <Select Tools> button. From the <Tool Type> drop down menu 
select Spot Drill. 

 
8 Click the <Select> button to select this tool. 

9 In the Group Name field enter “Chamfer OD” and click <Apply>. The 
dialog should now appear as shown below: 

 
10 Click on the active <Options> button to open the Pattern Finishing dialog. 
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11 Enter -.025 (-.63) in the Axial Depth: field. You activate this by clicking on 
the thickness button. Your dialog should appear as shown below: 

 
12 Click the <OK> button to return the Surface Group Parameters dialog. 

Select Surfaces for Machining 
At this point you should still have the Surface Group Parameters dialog open. 
Make sure Machine All Surfaces is selected in the Toolpath Settings section 
which sets all surfaces of the solid to machine surfaces.  

Click the <Close> button to return to the Face Window.  
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Create Surface Machining Pattern Curves 
Pattern curves are created the same way as 2D profile curves. Pattern curves 
are 2D/3D profiles that are projected onto a 3D surface in order to calculate a 
tool path. 

Create the Geometry for the Surface Machining Pattern Curves 
The first step in creating this chamfer is to create the geometry for the 
projection curve for the chamfer. To do so, you will copy the circle created in the 
previous window.  To do so: 

1 From the Window menu, choose the Cross Hole Chamfer window as 
indicated below: 

 
2 Once in the Cross Hole Chamfer window, click the CAD/CAM switch to 

enter the CAD mode 

3 Using the Selection icon, click on the circle created previously. Doing so will 
select the geometry. 

4 With the circular geometry selected, from the Edit menu choose Copy. 
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5 From the Window menu, choose the Chamfer OD window as indicated 
below: 

 
6 In the Chamfer OD window, click the CAD/CAM switch to enter the CAD 

mode. 

7 From the Edit menu, choose Paste to paste the circular geometry into the 
new window. 

8 Click anywhere in the Face Window away from the shape to deselect the 
geometry.  

9 Click the CAD/CAM switch to return to the CAM mode.  

Create the Surface Machining Projection Curve Profile 
1 Choose the Chain Geometry icon 

2 Click your cursor on the circle you just pasted into the face window. Doing so 
will create the projection curve. Your window should now appear as shown 
below: 
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Verify the Tool Path 
Once you have created the Part Feature and established a Projection Curve 
you can visually verify the tool path PartMaker has calculated. To do so: 

1 From the Part Features menu choose Verify Work Group Tool Path.  

2 In the Tool Path Verification Options click the Do not show tool radio button  

3 Enter a Verification Delay of 0. 

4 Click <OK> to show the calculated tool path. Your screen should appear as 
shown below: 

 
Notice above that because the Solid Model is not chamfered, you need to specify 
an Axial Thickness to create the chamfer. 

5 From the Part Features menu choose Hide Work Group Tool Path.  

6 As before, you should now “lock” your tool path by opening the Surface 
Group Parameters dialog and clicking the “Lock Toolpath” button 

Save Your Work 
It is always a good idea to save your at various points in the part creation 
process in PartMaker. To do so: 

From the File menu choose Save or press <CTRL + S> on your keyboard 
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Generate a Process Table 

A process table shows you all of the processes for a part. When PartMaker 
generates a process table, all cutting conditions such as feedrate and spindle speed 
RPM are calculated automatically based on the tools and material information.  

1 Choose Generate Process Table from the Job Optimizer menu to display the 
Process Table Options dialog as below.  

 

2 Click <OK> to display the process table window as shown below. 
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Reordering Operations 
Next, you will reorder your operations so they are in the correct sequence, i.e. the 
second OD turning operation will be placed after the milling operations on front face 
of the part. To do so: 

1 Click on process #3 (P03) so that is selected as shown below: 

 
2 Click the arrow BENEATH process #6 (P06) to place process #3 (P03), the 

second turning process, after the face milling operations.  Your completed 
Process Table window will appear as shown below: 
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Simulate the Cutting Process 
Once you are satisfied with the appearance of your Process Table you can simulate 
cutting. To do so: 

1 From the Process Table, click the <Simulation> button in the upper left 
hand corner of the Process Table or just press the <Space Bar>.  

2 Because this part does not have any sub spindle operations and thus you are 
not ejecting it from the sub spindle upon completion of machining, you will 
be prompted with the warning below: 

 
3 Click the <Yes> button to continue into Simulation.  

4 When the Simulation Window appears, press the <Space Bar> or choose 
Start Simulation from the Simulate menu to initiate 3D simulation.   

5 Once simulation is complete, choose Show Finished Part from the Solids 
menu. Your completed part should appear as shown below: 
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Generate an NC Program 
1 Choose Post Config File= ? from the Job Optimizer menu to display the Open 

Post Configuration File dialog. 

2 Select the Swiss_Demo.PST post processor 

3 Click the <Open> button as shown below to load the post processor. 

 
4 Choose Generate NC Program from the Job Optimizer menu. You may again 

be prompted with the Warning dialog below. 

 
5 Click the <Yes> button to continue. 
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6 When you generate an NC Program for the first time during a programming 
session the Post Options dialog is displayed as shown below: 

 
7 Click the <OK> button to open the Save NC Program File As dialog. 

8 Type a name for your NC Program, such as “ASM_Tutorial” and click the 
<Save> button 

9 Your NC Program files will be displayed as shown below: 
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